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1. Introduction 

 

This guide is intended as a beginners guide to Primavera. By the end 

it, you should be able to confidently enter information into Primavera, 

and be able to present it in a sharp and meaningful manner. 

 

This guide will also look at resources, multiple layouts, progress 

reporting, filters and target programmes. 

 

The assumption when writing this guide is that Primavera has already 

been loaded onto the user’s computer. Further, it assumes no 

knowledge of Primavera by the user, but it does presume a level of 

computer literacy in the user. 

 

The first thing to note about Primavera, and to bear in mind as you 

work through this tutorial, is that it saves every change made while 

you work. As such there is no simple “undo” button – any changes 

made can only be reversed by re-entering the data. When you exit the 

programme the only thing that you are asked to save is the layout that 

you have defined: everything else has been auto-saved. 

 

A recommended way of using this guide is to follow the steps first on 

the example provided, then on a project which has more relevance to 

you.  
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Primavera does allow you to have more than one project open at any 

one time – simply open or create another project and you can move 

between the two projects at will by selecting the project from under 

the “Window” tab at the top of the page. 
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2. Getting Started 

 

The first step is to open the installed programme: 

 

 

 

Select the Primavera Project Planner icon in the Primavera programme 

folder. 
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Once Primavera has been opened, your welcome screen should look 

something like this…. 

 

 

Note: you may be asked for a User Name and password. Unless 

defined otherwise in the set up, your password is the same as the user 

name. The user name is as defined in set up. 
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To start on your first programme you need to select the menu “File” 

and Option “New” 

 

 

This will open this menu on-screen: 
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Project Name: This is a 4 character code that will identify your 

programme. It can be any alphanumeric 

character. 

Note that the new project will be saved in the 

folder c:\p3win\projects. It is good practice to 

set up a “Project” folder which will keep the 

project files together in one place. The reason 

for this is that a Primavera project consists of 24 

individual files: a single folder containing several 

projects would have hundreds of files in it! 

Number/Version: This indicates the revision number of the 

programme. 

Project Title: This is the title of the current project 

Company Name: This is the name of the company for whom this 

work is being done. 

Planning Unit: This is the planning unit of the programme: it is 

the minimum duration (except 0) of any activity. 

It can be any unit from Hour to Month. 

Workdays/week: This sets up, on your base calendar, your 

working days schedule. 

Week starts on:  This is the first day of the week. For instance, 5 

workdays a week in a week starting on Monday 

would mean Monday to Friday are work days. 

In some countries there is a six day working 

week, starting on Saturday. Thus there would be 

6 workdays/week and the Week starts on would 

be set to Saturday. 

Project Start: This is the earliest work day of the project. Note 

that it may be desirable to have a Project Start 
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several weeks before the first activity, in order 

to be able to indicate supply/design milestones 

required for work to commence. 

Project must finish by:This is the immutable end date of the project. 

It can, however, be changed at a later date. 

Decimal Places:  Generally used in resource assignment and 

calculation (not in calculation of the programme: 

Primavera does not support fractions of a 

planning unit). 

NB: YOU MUST “TAB” BETWEEN FIELDS OR MOUSE CLICK ON 

THE NEXT FIELD TO BE ENTERED. PRESSING ENTER WILL TAKE 

YOU IMMEDIATELY TO THE NEXT SCREEN AND THE DETAILS 

NOT ENTERED IN WILL NOT BE SAVED AS PART OF THE 

PROGRAMME. 
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After all of this information has been entered, we have a screen that 

looks like this: 

 

Note that a separate folder in \projects has been created called 

\house. (This was done in Internet Explorer) 

 

Once this information has been entered click the “Add” button (i) and 

your project has been created. 

 

 

 

 

 

 

 

 

3. Entering Your First Activities 

i 
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Upon entering your project you will be greeted by this screen: 

 

 

 

Before continuing any further you must enter the first “Activity ID” or 

activity number. All future Activity IDs will follow this number 

sequentially, increasing the number by a fixed amount. The Activity ID 

can be Alphanumeric. 

 

Enter “A010” and either press enter or click the mouse cursor on the 

tick. There will be a thick black line around the Activity ID box 

indicating that this is the field being edited. Press the right arrow to 

highlight the “Activity Description” box, and enter “Start Project” in 

this field. 
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Once entered, it should look like this: 

 

 

Press the down arrow button (or the “plus” sign) and notice that the 

Activity ID auto-increments as the new activity appears. Enter in the 

next several activities so it looks like this: 

 

 

The activities for your first programme have been entered. 

 

Note that the amount by which Primavera auto-increments the next 

activity can be adjusted by selecting “Tools” – “Options” – “Activity 

Inserting…”  from the drop-down menus. 
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Finally we need to assign each activity a duration. This is done by 

highlighting the “Orig Dur” box and entering in the required duration. 

Enter the durations as shown below: 

 

We are now ready to apply logic to our programme, but before we 

move on we need to correct the project layout… 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Establishing Your Layout 

 

Using your mouse, move the cursor over the thick black line 

separating the Activity details and the Gant chart until it appears as 
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two vertical lines bisected by one horizontal line with arrow heads 

pointing left and right. 

 

 

Now press the left mouse button down and drag the cursor to the 

right: once you have moved the cursor across two thirds of the screen, 

release the mouse button. 

 

 

Several new columns are exposed, as shown above. At this point in 

time we do not need those columns. 

 

 

 

 

 

 

 

 

 

 

 

 

Press F11 and this menu should appear. 
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The first thing we need to do is get rid of the columns which we don’t 

need. Highlight “Remaining Duration” (press the down arrow 3 times 

or click on it with your mouse) and either press the delete button on 

your computer or click on the “-“sign in the top left corner of this 

menu with your mouse. 

“Remaining duration” should disappear and “Percent complete” should 

now be highlighted. Delete this line also. Next highlight “Resource” 

which should now be visible on your menu. Delete this and the next 

item that appears, “Budgeted Cost”.  

 

 

 

 

 

You should be left with this: 
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Next we need to align out columns correctly. Using your arrow keys, or 

by clicking on it with the mouse, highlight the “Align” of “Early Finish”. 

Next press the letter “C” and enter: the Alignment should change from 

left to centre. Alternatively you can highlight the down arrow symbol 

next to the “+” sign and select “centre” from the options. 

 

Repeat this process and centre-align Early Start, Original Duration and 

Activity ID. 

 

Finally we can adjust the column widths. Highlight the “Width” cell of 

“Early Finish” and type in the number 10 and enter. Repeat this 

process with “Early Start”. 

 

In this menu we can also add columns. Highlight the empty space 

under “Early Finish” then press the down arrow button we used to 

select the alignment earlier. The list of columns available for adding is 

then displayed. Highlight and click on one to bring it into your layout. 
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Now we have our layout looking how we want it, click the “OK” button 

to return to the main screen. Next highlight the black line separating 

the activity detail and the Gant chart and drag it back to maximise the 

Gant area visible while still displaying all of our columns. 

 

Your screen should look something like this: 

 

 

 

Our next aim is to format the bars. This can be done by either clicking 

the “Bar” icon (1), Format > Bar (from the drop-down menu), or by 

pressing Ctrl+F11. 

 

 

The following menu should appear: 

1 
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Four bars are shown here: two of them are visible (The Early and Float 

Bars). To avoid confusion, we will delete all of the bars which we do 

not need to see. Highlight “Float Bar” either by pressing the down 

arrow until it is highlighted or by clicking on it with your mouse; press 

delete and this window should appear: 

 

 

 

Click “Yes” and the bar should disappear. Repeat this with the “Late 

Bar” and “Resource Early Bar”. 

 

 

Your window should now look something like this: 
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i The “position” is the position of the bar on the activity line. “1” is 

central, “2” is below that and “3” is above. “4” is further below 

and “5” is further above. 

ii “Visible indicates that the bar is visible. 

iii  “Key” indicates that this is the key bar from which links are 

shown 

iv “Progress” Indicates that, once progressed, progress is shown on 

that bar 

v “Critical” indicates that if an activity is critical, it is shown as 

such by being coloured as indicated (see iv overleaf) 

vi “Neck” states that for periods of inactivity, such as holidays or 

weekends, the bar is “necked” 

 

i ii 
iii 

iv 

v 

vi 
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i This allows you to show the bar “necked” 

 for periods of inactivity, such as 

weekends or holidays. By default, the bars are necked when, due 

to progress or resource constraints, no work can take place. 

ii This option becomes relevant when a “target” or “baseline” 

project has been defined, and allows you to show criticality on 

the target bar based on either the current project or the target 

project 

iii Percentage complete can differ greatly from remaining duration 

(a ten day activity can be 90% complete but, due to late delivery 

or access problems, still have a 10 day estimated remaining 

duration). This option allows you to choose which to display. 

iii 

ii 

i 

iv 
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iv Finally this option allows you to mask or show the criticality of 

activities on the bar or endpoints. 

 

“Endpoints” allows you to define the type of endpoint used for the 

various bars available, as well as their size and colour. 

“Pattern” allows you to apply a pattern to the fill of the bar. 

“Modify” allows you to further modify the details of that bar. Click on 

the “Modify” button to proceed to our next step in defining our layout. 

 

This menu will appear: 

: 

 

i 
ii

iii

v

vi

iv

vii

viii

ix
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i This is the description of the bar – it can be renamed as 

anything. 

ii This, again, is the position of the bar. The number can be 

adjusted both by highlighting it and entering in the new number, 

or by clicking (with your mouse button) the up and down arrows 

to the right of the box to increase or decrease the number. 

iii.  This is the Start and End point definition area. At the moment 

they are defined as Early Start and Early Finish. However, a Late 

Bar could be defined, with the Start Point defined as “Late Start” 

and the Finish Point as “Late Finish”. Alternatively a Float Bar 

could be shown, its start point being “Early Finish” and the finish 

point being “Late Finish”. 

The “Bar” category allows you to define the type of bar. It can be 

a bar, a solid line or a dashed line. The “size” category would 

then define the height, in pixels, of this bar. 

iv. Primavera allows the definition of Milestone points, or 0 duration 

target dates on your programme. This box allows you to define 

the height, in pixels, of these milestones. 

v. This defines whether the end point or bar is shown, or is merely 

outlined. 

vi. This allows you to define the colour of the bar (unless critical) 

vii. “Separator” allows you to define the separating item if more 

than one data item is defined in one part of the bar. More details 

of this will follow in the “Label” description section. 

viii. This shows a sample of what the bar will look like. 
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If we click the “Label” tab (ix) the menu will change to this: 

 

 

This allows us to add labels to our bars in various positions. The 

impact that these labels will have on the layout is shown on the 

sample below. Any data item from the activity detail can be added as a 

bar label. 
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In the same way as we have adjusted activities in other menus, alter 

the bar structure layout so that it looks like this: 

 (Changes are indicated        ) 
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And alter the Label layout as follows: 

 

 

If you click “OK” in the “Modify Bar Definition” window and “Close” in 

the bars window our layout should now look something like this: 

 

 

Now we are ready to move on and develop our programme. 
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5. Developing the Programme 

 

With our layout established we can develop our programme and apply 

logic to it. It currently looks like this: 

 

 

We need to link the activities together to form our construction 

programme (plan or schedule). 

 

There are several ways of nominating successors and predecessors for 

activities. The quickest is to use our mouse. In order to do this we 

need to turn the relationship lines option “on”. Click your mouse over 

the   button in the top toolbar. You can now link activities with your 

mouse. Place your mouse on the bottom right hand corner of activity 

A010 until a three-pronged forked arrow appears. Now depress the left 

mouse button and drag to the start of the activity you wish to link to. 

 

Try this out from A010 to A020. Once the three pronged cursor is at 

the start of the activity bar you would like to link to, release the mouse 

button and the link should appear:  

. 
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The second way of linking activities is through the Successor input 

window. Highlight activity A010 and press Ctrl-J .This window appears: 

 

You can see the activity that we have designated A010’s successor 

shown here. The “Rel” column indicates the type of relationship that 

exists between the two activities. In this case it is a FS – Finish to 

Start, but could be a Finish-Finish, Start-Start or Start-Finish. 

The Lag indicates any Lag you want to put on the link. For instance, if 

it was a FS with +3 days lag, the second activity could only start three 

days after the finish of the first. Likewise a SS with +5 days lag would 

mean that the second activity could only start five days after the start 

of the first. 

 

The lag can be negative. For instance, a FS relationship with a -3 day 

lag would mean that activity two could start three days before the end 

of activity one. 
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Press Enter. The box should jump immediately to the next activity and 

look like this: 

 

 

Highlight the area underneath the “Activity ID” column heading and it 

will highlight blue an area in which you can enter an Activity number. 

Type in “A030” and press enter. 

 

The programme will automatically enter in the successor’s description 

and will provide a default link of Finish to Start with 0 days lag. 

 

Instead of typing in “A030” you could merely, once a blank area has 

been highlighted under “Activity ID” press the down-arrow and select 

the required activity ID.  
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This will appear: 

 

Now highlight the activity that you would like to link to and click it with 

your mouse. It will then appear in your successor list. 

Next make A040 the successor of A030, and A050 the successor of 

A040. However, we need a different kind of link between A040 

(Foundations) and A050 (Floor Slabs). We know that 5 days after the 

completion of the foundations the floor slabs should be in. Thus, we 

can change the link type to a “FF” link and the lag to 5 days. 

We also know that two days after the start of the floor slabs, we can 

start on the superstructure. Thus the link from A050 to A060 is a SS 

with 2 days lag. 

However, we also know that we will need at least 5 days after the 

completion of the Floor Slabs before the superstructure can be 

completed. To show this we add a second link between A050 and 

A060. 

 

Enter in the links mentioned above, and the following: 
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A060 to A070 – FS 

A070 to A080 – FS with -5 day lag 

A080 to A090 – FS 

A090 to A100 – FS 

Then close the Successor activity box, either by pressing Ctrl-J again 

or by clicking the small “x” in the top right corner of the box. 

 

Our programme is now linked. Primavera now requires the programme 

to be “scheduled” in order to calculate the new end date. Press F9 to 

schedule the programme. 

 

The result should be: 

 

 

 

Our first problem is that the full width of the bar chart is not visible on 

the screen. Move your mouse cursor over the timescale and double 

left-click.  
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This window should appear: 

 

The cursor on the bar under the word “Density” is flashing. Click on 

this cursor and drag it to the left and right. You will see your timescale 

expand and contract. Adjust it so that the last week visible on the right 

hand side of the screen is the first week in June. Release the bar-

adjusting cursor and press “OK”. 
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Your screen should now look like this: 

 

 

We are now ready to organise our programme. 
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6. Organising the Programme 

 

Primavera can organise projects in two main ways: through Activity 

codes and through a “Work Breakdown Structure” (WBS). 

 

6.1 Organising By Work Breakdown Structure 

 

The WBS is a structured way to lay out a programme: it can 

accommodate several levels of programme. Establishing your WBS 

involves typing in a mini-programme of headings. 

For example: 

1  Contract Start 
1,1   Site Establishment 

2  Demolitions 
2,1   Church 
2,2   Church Hall 

3  Construction - Flats 
3,01  New Flats - Structure 

3,01,1   Basement 
3,01,2   Ground Floor 
3,01,3   First Floor 
3,01,7   Roof 

3,02  New Flats - Brickwork & Finishes 
3,02,1   Basement 
3,02,2   Ground Floor 
3,02,3   First Floor 
3,02,7   Roof 

4  Construction - New Church 
      4,01  New Church - Structure 

4,01,1   Foundations 
4,01,2   Ground Floor 
4,01,3   First Floor 

      4,02  New Church - Brickwork & Finishes 
4,02,1   Ground Floor 
4,02,2   First Floor 
4,02,3   Roof 

    5  External Works 
    6  Handover 
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For complex programmes, it is wise to establish the WBS before the 

actual programming is started. 

 

 

Select Data-WBS… from the drop-down menus. The following window 

will appear: 

 

This is the WBS Editor window. 

The first thing we need to do here is set up the structure of our WBS. 

This is done by clicking the “Structure” button.  
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The following window appears: 

 

This is the WBS Structure Editor. 

We want to set up a simple two level WBS, so highlight the number 10 

(this is the number of characters allowed in that level: it can be any 

number from 1 to 48). We want it to be two characters wide, so type 

in the number 2. 

Next we need to identify the separator that will appear between fields. 

Click on the box below the “2” that has just been entered and type a 

“,”. 

Our second level also requires a two character field: in the box below 

Level 2 enter another “2” and place another “,” below it. 

 

The easiest way to navigate this window is by clicking on the box 

where information is to be added with your mouse cursor and entering 

the information required. 
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The WBS box should now look like this: 

 

Click “OK” and we return to the main WBS Window. 

 

It should now look like this: 

 

Note that in the “Code:” box a comma is now visible. This indicates 

that we can now enter in two levels of information here. 

Click on the “+” sign and the cursor appears in the code box, to the 

left of the comma. Type in “01” and press Tab. The cursor should 

move to the title box. This is the description of that WBS Heading. 

Type in “House” and press enter. 
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You have created the first level of your programme. 

Click the “+” sign again and type in 0101. Note that as the cursor 

reaches the comma after the first “1” it automatically moves on to the 

second level of the WBS. Again press “Tab” and enter the description 

“Start Up” and enter. 

Enter in the following descriptions as shown 
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We now need to apply this WBS to our programme. Press “OK” and 

return to the programme. 

There are two ways in which we can assign the WBS levels to the 

programme. The first is to create a column called “WBS” and enter the 

information there. 

Press “F11” and highlight the space below “Early Finish” in the new 

window. Then highlight the down-facing triangle next to the “+” sign in 

the window and press the key “w”. The menu should scroll straight 

down to “WBS”. Press enter and it will appear in your column 

selection. Alter the alignment of this column to “Center” and alter the 

width to 8. 

 

Your window should now look like this: 

 

Click “OK” and drag your black line between the “Early Finish” column 

and the Gant chart to the right. The “WBS” column should appear. 
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Now move the mouse pointer over the WBS cell of activity A010 and 

click. 

 

If you now click next to the “,” in the input area the  should 

become . This means that this “button” is now active. Click on it with 

your mouse cursor and the list of data items available to place there 

should appear. Highlight “01,01” and press enter: that value should 

now appear in the WBS column. 

Next, highlight (by clicking it with your mouse) the WBS column for 

Activity A020. Simply type in the characters “0101” and press enter: 

they should appear in the box separated by the comma. 
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Enter the remaining WBS activity codes as follows. 

 

We have now told Primavera HOW we want the programme organised: 

now we must tell it to organise it so. 

 

Click the “Organise” icon on the toolbar. 

This window will appear: 

 

This opens, by default, on organising by “Activity Code”.  
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Press the button by the words “Work Breakdown Structure” and the 

window should change to this: 

 

 

1. These are the two WBS Levels that have been defined in the 

WBS Structure. This states that both are visible, and the “Font” 

is the size of the heading displayed on the screen.  

2. “Bkgrnd” and “Text” are the colours of the background and the 

text in these headings.  

3. “Sort by:” defines how the activities are sorted within each band 

4. “Options” takes you to the following window: 

1 

2 

3 

4 
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While we are here, we want to display the WBS number (its value) as 

well as the description in the header band. Tick the “Value” box 

beneath the text (1) “Text in bands:” 

 

Now click “OK” (2) and we return to the “Organise” window. 

 

We can change the settings here for colours, fonts, and whether each 

heading has a “Total” band at will. For now, merely highlight the Level 

2 “Total Cell” and press “N” – “none” should appear in the box. Press 

enter and enter again. 

 

 

 

 

 

 

 

1 

2 
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You should return to his screen: 

 

Here we see the headings we defined in our WBS layout assigned to 

the activities, in the layout we asked for.  

Note that the WBS headings have the number we assigned them in the 

header bar. 

You can summarise these bars under their respective heading by 

double mouse-clicking on the header lines (*). 
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6.2 Organising By Activity Code 

 

The second method of organising activities in Primavera is by Activity 

Code. You can see the current activity codes at the Menu option    

Data – Activity Codes. This window will appear: 

 

i. This is the four letter character code assigned to this Activity 

code as its name 

ii. This is the character length of the field 

iii.  This is the description of the field 

iv. These are the “Value”s of the component parts of that activity 

code. For instance, if a Code field is called “Level” with a 

length of “1” the values could be G, 1, 2, 3, 4 and the 

descriptions “Ground Floor”, “First Floor”, etc. 

i ii iii 

iv v 

vi 
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v. This is the order in which those items should be sorted within 

the activity code. For instance, Primavera could assume that 

“G” comes after the numeric codes. In this instance we would 

place a “1” in the “order” column by G, a “2” by “1 – First 

Floor”, etc. 

vi. “Transfer” allows us to transfer a coding structure from 

another programme.  

This button will take you to a window in which you can 

identify the programme from where you would like the 

activity codes drawn. 

 

Highlight “RESP” in the name field and then click on “RESP” in the text 

edit box (a). Your cursor will appear in that field. Delete the characters 

RESP there and replace them with “BLDG” and press Enter. 

a 
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Now click on the “Description” field of our new Activity Code “BLDG” 

and change the description to “Building”. The length of the field can 

remain at 4. 

Now change “AREA” to “PHSE” and enter “Construction Ph.” as its 

description. 

Delete the remaining codes by highlighting them and pressing the 

delete key. 

The Activity Code box should now look like this: 

 

We now need to add values to each of the Activity Codes defined. 

While highlighting “BLDG” click in the Value area of the lower box. You 

will be asked if you wish to save your structure edits. Primavera is 

asking if you want to keep the new code structure that you have 

defined and delete the old structure. Click “Yes” and highlight the 

“Value” box again. Make your first Value “01” and press right arrow so 
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that your cursor now rests in the description field. Type “House” and 

press enter. 

 

Highlight “PHSE” and repeat this process of entering values until you 

have the following codes entered: 

 

Then close this window. 
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We can apply these codes to our programme in the same way as we 

applied our WBS codes. In this instance, create two columns: one with 

the data item “BLDG” and the other with the data item “PHSE” 

 

 

Our Gant Chart will now look like this: 

 

Now it is the simple matter of entering our codes. The code “01” for 

“BLDG” applies to all activities, while we will encode “PHSE” to match 

our WBS. 

               Note this change 
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We now need to tell the programme to organise by our Activity Codes 

rather than by the WBS. Press the “Organise” icon 

 

And select “Activity Data Item” as your “Organize by” data. The 

window should change to this: 

 

 

We want to Group our activities by the codes that we have defined. 

Click under “Group by” and enter our defined codes: 
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Note in the example shown the “Font” has been altered. This can be 

changed by highlighting the font and selecting the required font in the 

Input area. 

 

Press “Reorganise Now” and the schedule layout should change to this: 

 

 

Our colour scheme has changed in line with our new layout and 

“Snagging” has moved from our previously defined heading of 

“Finishes” to “Snag and Handover”. 

 

The Activity Code form is useful in two main instances: where there is 

repetition and where different layouts might be required by different 

parties. 

 

Imagine if our example had ten houses: our WBS would run for several 

pages, but the Activity Code will only have to be adjusted by adding in 

one code per house – a house number identifier. 
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Further, in that instance a reorganisation could tell our Services 

Foreman exactly what his programme will be for the ten houses. First 

we would organise it by “Construction Ph.” and then by “Building”. 

 

The below example took just a few minutes to create, organise and 

sort. Note that in this example I used a “Filter” to show only the 

“Finishes” activities i.e. those activities with Building Ph. Code “04”. 

 

 

 

So how do we filter our programmes? 
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7. Filtering the Programme 

Our programme should currently look something like this: 

 

We need to create something to filter by: create an additional Activity 

code, with values, as follows: 
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Create a column for “FMAN” and distribute the three foremen as 

follows: 

 

 

We can now use our filters to sort by Construction Phase, Foreman or 

a combination of the two: 

 

Click the filter icon: , and this window will appear 

 

1 

2 
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To remove confusion first delete the current filters from FL-01 

onwards. Highlight FL-01 and press the “Delete” button. Confirm that 

you do wish to delete the filter when asked and the filter disappears. 

Repeat this process for the remaining filters until you are left with: 

 

 

Now click the “Add” button. The following window appears: 

 

Click OK. You are then taken to: 

 

1. This is the name of the filter – it can be renamed as anything 

1 
2 

3 

4 
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2. This section defines whether, in the case that two conditions are 

imposed on the filter, activities are required to fulfil all conditions 

or only one of the conditions 

3. In this section the filter conditions are defined. Any of the data 

items defined for an activity can be used in a filter, from dates to 

activity codes to resource data. 

4. Here the “condition” for the filter to apply is defined. It can be 

any mathematical function (i.e. <,>, =, etc.) and any value, 

either of the data item mentioned in “3.”, or any other data 

item. 

 

An example would be: 

 

 

Here we are telling the computer to apply the filter (i.e. select and 

display that activity) only if the Foreman is equal to 01 (Joe Bloggs). 
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A more complex filter would be: 

  

This tells the computer to select an activity if 

(i) the Foreman is 01 (Joe Bloggs) AND 

(ii)  the Construction Phase is “Within the Range” of (WR) 02-

04 (i.e. is 02, 03 or 04 – Substructure, Superstructure and 

Finishes) AND 

(iii) Has an early start date after the 1st April 2002. 

 

In this case, only activity A080 will be selected. 

 

Filters are often used in large projects for progress reporting: it is 

difficult to sort through hundreds of activities to find those that have 

started or finished. A filter can reduce the hundreds to a few dozen. 
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A useful filter for a “look ahead” view would look like this: 

 

This states that the activity should be visible is any of the “early dates” 

– either “Early Start” or “Early Finish” occur within the window “DD” 

i.e. the Data Date (The date on which the programme was last 

scheduled) and “DD+1M” (Data Date +1 Month). Applying this filter to 

our programme results in: 

 

          

Only activities with a portion of their duration in the area indicated 

above have been selected (the Data Date is shown by the blue line, 

and is the 1 March 2002. The filter has selected activities that run 

between the 1 March and the 1 April 2002).   

 

So we have a filter that we can use when reporting progress in our 

programme. Progress reporting will be covered in Chapter 9. 

 

Until then, restore our layout to include all activities (i.e. run filter 

“All”). 
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8. Resources 

 

Primavera has the facility to receive resource data, apply costs to the 

resources, report these resources graphically, level the resources and 

apply actual expenditure against budgeted. 

 

The first step is to establish a resource “dictionary” of the resources 

we wish to define for the project. Data > Resources opens the 

following window: 

 

1. The resource “code” 

2. The units that apply to this resource (e.g. m3, Hours, litres) 

3. Whether the unit is “Driving” or not (i.e. whether the duration is 

driven by the resource quantity divided by the resource output) 

4. The calendar to be used when this resource is applied. 

5. A description of the resource 

1 
2 

3 5 

6 7 

4 
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6. Resource limits (used in resource levelling) 

7. The cost, if required, per unit of the resource. The cost can 

reflect the monetary cost (if desired) or another aspect, such as 

the number of man hours required to place a unit of the 

resource. However, there are other ways to show this and this 

will be discussed later. 

 

Enter the data shown above. Each person has a normal limit of 1 and a 

maximum limit of 2. The Price per unit (i.e. Cost per Day) of Bob is 50, 

Mr Dixon is 35 and Wendy is 25. Nuts and Bolts are a material 

resource (versus a manpower resource) and have no limits or, in this 

example, a price per unit. 

 

After entering the Price/unit you will be asked if you would like to 

calculate costs now. Select “Yes” in each instance. 
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Once the resource data has been entered, close the window. Our next 

step is to apply these resources to our activities. Highlight the first 

activity – A010: Start Project – and press Ctrl+R (or from the drop-

down menu, View > Resource Detail). The following window will 

appear: 

 

Now click the “+” sign and the down-triangle and your will be 

presented with a list of resources which you can apply to this activity. 

Let us assume that Bob is required to start the project – to sign the 

papers and set out the works. Select “Bob” as the resource and enter 

1 unit per day. The budgeted quantity should immediately become “1” 

(i.e. 1 unit/day * 1 day). 

 

Now, with the cursor in the “Resource” box of this window (i.e. 

highlighting BOB), press the right arrow to create another resource. 

 

This time use the resource “Nuts and Bolts” and enter an amount in 

the Budgeted Quantity of “10”. The number 10 should also appear in 

the “Units per Day” column. 
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Highlight the next activity add resources as per this table: 

 

Act. ID Resource 1 Units/day Resource 2 Budg.Quant. 

A010 BOB 1 BOLT 10 

A020 DIX 1 BOLT 5 

A030 WEN 1 BOLT 20 

A040 WEN 1 BOLT 25 

A050 BOB 1 BOLT 20 

A060 DIX 1 BOLT 15 

A070 DIX 1 BOLT 15 

A080 DIX 1 BOLT 20 

A090 WEN 1 BOLT 10 

A100 BOB 1 BOLT 5 

 

Close the Resource window and change two of the columns to show 

the resource assignments… the column titles will be “Resource” and 

“Budgeted Quantity”: 
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Primavera cannot, unfortunately, show more than one resource in this 

view: it “lumps together” the resources so that the total Budgeted 

Quantity is shown for all resources applied to that activity. 

 

We can see how these resources are distributed across time in a 

resource profile. Press the  button (alternatively, from the drop-

down menu, View > Resource Profile or Ctrl+F7). 

 

This should appear at the bottom of the screen: 

 

This is the resource profile for the resource (or person) “BOB” – Bob 

The Builder. We can see he spends a total of 8 days on site, the 

majority towards the end of March. 

 

We need to modify this to tell us exactly what we want.  
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Press the “Display” button (under the “Select” button in the Resource 

Profile/Table  window) and this window will appear: 

 

 

1. Would you like to see the Units or the Cost (as entered) of 

those units? i.e. Units or (Cost/Unit) x Units. 

2. Would you like the graphs to show their data based on “Early 

Start” dates or “Late Start” dates. 

3. Should the graphs show data collected from all activities or 

only the currently selected activities. 

4. Gives the time interval for the graph data (i.e. a new bar in a 

histogram chart or a new plot-point in a line (“curves”) graph. 

5. Allows you to choose the type of graph to be displayed – 

histogram or curves (line graph). 

1 2 3 

4 5 

6 
7 

8 

9 
10 

11 
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The following (6 to 10) apply to histograms only: 

 

6. Do you want the graph to display totals per defined time 

interval (4.), average or peak usage. 

7. Histogram format:  Area (  )  

or Bar (  ) 

8. Values – these are used once progress has been entered and 

the requirement is to compare planned and actual 

9. Allows you to define the calendar to be used when calculating 

average resource usage (i.e. may cause a difference if a 

resource is only used on a four day week when the activity 

runs through a five day week) 

10.  Drawing of Limits and Overloads refers to resource peak 

usage and levelling. 

 

11.  Refers to the resource usage curves: allows you to define 

different lines for the various curves being shown. 

Alternatively Primavera will use different colours to highlight 

the different data lines. 

More information on these can be found by pressing the “Help” button. 
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Change the contents of the window to this: 

 

Press “Close” and select the resource “BOLT” from the window in the 

drop-down menu in the Resource Profile/Table area. Your histogram 

display should look like this: 

 

 

This tells us that we will be using a total of about 120 bolts and their 

distribution across the project. If we want to see the precise number 

we should select the resource table, rather than the graph. 
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Press the  button (Or View > Resource Table or Shift+F7) and 

select “BOB” from the drop-down resource list. Your display should 

change to: 

 

Here we now see the weekly total number of days that each person 

will be required to spend on the job, as well as the weekly total 

numbers of bolts used.  

 

Exporting this data out of Primavera is tricky… it is a case of finding 

the correct report type and modifying it to your requirements. 

 

To export this report we need to run report RL-01. It can be found 

here: 
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We are then faced with this menu: 

 

Report RL-01 is already selected. Click the “Modify…” button and these 

windows will appear. Make the modifications highlighted to create the 

report we require. The various screens can be accessed by clicking the 

“Tabs” under the Title. 

 

Leave this selection 
blank to select all 
resources. If we wanted 
to omit a resource (e.g. 
Nuts and Bolts) we 
could put the condition 
“NE” (not equal to) 
under profile and the 
resource “NUTS” under 
“Low Value Resource” 
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Important points to 
note here are to 
Generate the report in 
P3 (1), to organise by 
Resource and produce 
a summary report (2) 
and to display row 
totals on the left (3). 

The selection is 
irrelevant to us – we 
want a report for the 
whole project. 
However we could 
filter for any of the 
codes that we have 
established, in the 
same way that we 
filtered the project in 
Chapter 7 

Finally we set the time 
we require our report 
to span (1) and the 
time unit we require 
the report (3). We can 
also specify whether 
we want the report to 
show Total, Peak or 
Average resource 
usage (2). 

1 

2 

3 

1 

2 

3 
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With this information set we can run the report. Click the “Run” button 

in the top right hand corner of the window. 

 

This window will appear: 

 

We want to see this report on screen so click “OK” and the Primavera 

report writer will produce the required report: 

 

To get this report into Excel format, where the data could be 

manipulate and the report format modified, we can first copy and 

paste this data into Microsoft Word, then copy and paste it again onto 

an Excel spreadsheet.  
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For instance, you will notice that due to the width of the report, it 

spans two pages. We can copy and paste both pages into Excel and 

reformat them to a single page. 

 

Note that the export copies only the values of the data and formulae 

will have to be replaced (e.g. the weekly totals). 

 

A direct copy from Primavera Look to Excel WILL NOT WORK. 
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9. Reporting Progress  

 

The first thing that we should do though, is save our original 

programme as a “baseline” programme against which future revisions 

and progress updates can be measured. 

 

So open and run the filter for “All Activities” (FL-01) to restore all 

activities to our layout. Then save our current layout either through 

the drop-down menu or by pressing Ctrl+S. 

 

 

We now need to copy this programme. Again, from the drop down 

menus highlight “Copy…”: 
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That will open this window: 

 

 

1. Represents the programme being copied – A000 should be 

highlighted under the “Projects:” heading. 

2. This section shows what you want to copy the programme to. 

Ensure that the directory is correct (C:\p3win\projects\house). 

The first field required to be filled in is “Project group:” – enter in 

P101 (i.e. Progress Report 1 of programme A001). The second 

field will be our Revision – to indicate that this is a progress 

update 

 

 

1 

2 
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Press the “Copy” button and the programme is copied. 

 

Open up our newly created programme A101 through the File-Open 

drop-down menu and it will open over your original programme. 

 

We now always need to be able to compare our progressed 

programme to our original or “baseline” programme. We therefore 

need to call our original programme the “Target Programme”. We can 

identify it as such here: 

 

… This opens the following window: 
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With the Target space beside “1” highlighted press the down arrow in 

the input area and select “A000”, our original programme. Click OK 

and programme “A000” is set as the Target programme of A101. 

 

Now we need to show this target programme in order that, when 

progressed, we can see the variation in the bars.  

 

Press Ctrl+F11 to bring up our Bar editing window. Create a new bar 

under the current “Early Bar” and use these settings (changes 

indicated with a   ): 

 

Click on “OK” and “Close”. 
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Your display should adjust to this: 

 

The black line indicates the “target” or baseline programme; the yellow 

indicates the currently open programme. If adjustments are made to 

the programme, the yellow lines will move but the black lines will 

remain in their current positions. 

 

The next step is to organise our columns for easy data entry. Press 

F11 and arrange the columns like this: 

 

That is, replace the columns created for the Activity Codes with “Actual 

Start”, “Actual Finish” and “Remaining Duration”.  
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Click “OK” and your display should adjust to: 

 

 

We are going to report progress up to the 23 March 2002. Primavera 

has a facility whereby you can highlight the activities that could be 

affected by progress up to a particular date. Press the Progress 

Spotlight -  - button and the display will adjust to this: 

 

The progress spotlight, by default, highlights one week after the 

current Data Date. We need to adjust it to highlight the area we wish 

to progress. Move your cursor over the rightmost vertical blue line and 

the cursor will change to  . Drag the vertical blue line to the 23 

March 2002 and release. Your display should now look like this: 
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The five activities affected by the progress “spotlight” are highlighted 

in yellow. We can now enter our progress. This is done by entering 

Actual Start and Actual Finish dates in the relevant columns. Note that 

once an “Actual Finish” date is entered, the “Remaining Duration” 

automatically reverts to 0. 

 

Enter the following: 

 

In addition to the spotlighted activities, progress has also been 

entered for Activity A060: that activity has immediately become part 

of the “spotlight”. 

 

Once progress has been entered press F9 and schedule the 

programme to our new date, the 23 March 2002.  

 

The display should look like this: 
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A few things to note about the progress reflected: 

The projected time to completion now takes into account any links 

active on that Activity. For instance, A050 only has five days remaining 

duration, yet is pushed out to 9 April. The programme reflects the 

FF+5 day link from A040, which is due to finish on the 2 April, 1 week 

earlier. 

 

Other necks are reflections of weekends and non-work periods. For 

instance, the period of time immediately after the new Data Date is a 

weekend: there is no activity over a weekend so the bar is necked. 

 

Finally we can see the slippage suffered as a result of lack of progress 

in a column called “Variance Target 1 Early Finish” – this column 

measures the difference, in days, between the Early Finish of this 

programme and the Early Finish of the Target Programme. 

 

 

Here we can see that the late start of the project pushed back the 

initial activities by 1 day: later delays in foundations resulted in 7 days 
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being lost. Some early work on the superstructure has allowed us to 

recapture 1 day: the overall loss currently is 6 days behind 

programme. 

 

For the next progress update, copy the previous progress update into 

a new programme and report progress there. Primavera allows two 

targets to be nominated – slippage (or gains) on the end date can then 

be measured against the previous update and the baseline 

programme. 

 

So we’ve measured time, but how can we compare budgeted resource 

usage with actual? 

 

Highlight activity A010 and press Ctrl +R. Your resource window 

should open. 

 

We can enter actual resource usage in the “Actual this period” and 

“Actual to date” slots. If we imagine a situation where BOB lost his 

bolts and had to buy more, and as a result had to work overtime to 

get the job done, we could enter “1.5” as BOB’s Actual to date and 
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“20” as the Actual to date BOLT usage. The Variance should 

automatically update to “-0.5” and “-10”, indicating that there was 

overuse of resources by BOB (0.5 days) and BOLTS (10 No.). 

 

Act. 

ID 

Resource 

1 

Actual 

to 

Date 

To 

Complete 

Resource 

2 

Actual 

to 

Date 

To 

Complete 

A010 BOB 1.5 0 BOLT 20 0 

A020 DIX 3 0 BOLT 10 0 

A030 WEN 1.5 0 BOLT 15 0 

A040 WEN 5 7 BOLT 10 20 

A050 BOB 5 2 BOLT 10 15 

A060 DIX 2 19 BOLT 2 15 

 

After entering these, display the resource histogram and select, from 

your Display options, all three curves (however do not select “Show 

curves using different line types”). Select “BOLT” as the resource you 

would like to see the display of.  

 

Your display should look like this: notice how the higher bolt usage has 

peaked the histogram early, and the overall increase has pushed the 

totals up from around 140 No. to over 160 No.  
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The precise numbers can be gained by moving the mouse over the 

part of the line for where you would like the values and right-clicking 

with your mouse button. 

 

This window will appear: 

 

 

If the report we generated previously is run again it will accommodate 

the increased resources expended to date, and increase the projected 

totals. Thus the data can be exported to Excel and a comparative 

graph created. 
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10.  Conclusion 

 

This guide has taken you through the basic functions of Primavera. It 

has also given a firm grounding in navigating the menu options in 

Primavera and entering data. 

 

Armed with this information, and using Primavera’s extensive help 

function, it is recommended that you further look into using multiple 

calendars, constraints and the powerful “Global Change” function. 

 

For further general practice it is recommended that you access 

Primavera’s tutorial functions (the  button in the top toolbar will 

access these lessons. 
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Appendix A 

Exercise 1 

 

1. Take your original programme and organise it by activity code. 

Now copy the entire programme (highlight all activities, copy, 

paste under the last activity – you will be asked how you would 

like the activities renumbered: select Rename all Activities: 

Auto-increment. For more information use the help function in 

this window) 

2. Assign your new activities to a new “Building” activity code –        

House and assign the correct construction phase activity codes 

to the activities. 

3. Try reorganising your activities now on construction phase, then 

building. Link your activities so that each construction phase 

does not overlap 

4. Rerun your resource histograms. 

5. Repeat this process and add houses 3 and 4. Try filtering by 

foreman and work phase. 

 

 


